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Constructing Squares with a Variable Slider in the Coordinate Plane
Goal: An introduction to creating and using a variable in a

well-known setting – the square.

We will construct a slider whose current value will be the
length of the side of the square. As we slide the
slider to a new value, the side and size of the
square will automatically change (vary).
That is, the slider is a variable.
We will then use this variable to make a formula for
both perimeter and area.

Standard: California: CA4AF1.1 and CA4 MG2.0

Before: Teaching Activity: Constructing Squares in the Coordinate Plane

Note:  A great feature of GeoGebra is that “the value” of a line segment is its length. It “looks” like a
number and this value CAN be used as a number in a formula.  But it CANNOT be made into a
slider variable. Only a number can be used as slider and a slider variable is always just a number.

Setup GeoGebra for Construction (same as for Constructing Squares in the CP)
1. Open GeoGebra.
2. If not on, turn on the Algebra view and if on, turn off the Spreadsheet view.

To toggle, select commands: View -> Algebra view  and View -> Spreadsheet view
3. Turn on the Grid.

Right-click in empty space in Drawing pad and select Grid from drop-down menu.
4. Move Drawing pad to show only first quadrant

Select Move drawing pad  tool and then somewhere in the first quadrant, click and drag
Drawing pad down and left so that (0,0) is in bottom left corner.

5. Use your mouse scroll button to zoom in/zoom out to get the view you want1.
6. Turn on Point capturing.

GeoGebra usually does a good job of point capturing on Automatic. If you want to ensure
that new points are on the grid, then select command:
Options -> Point capturing -> On (Grid).

7. If you want, save these setting to default.
To have this be your default view when opening GeoGebra select command:
Options ->  Save Settings.

Construction: Draw a square whose side varies by moving a slider
1. Say:  We want to create a slider whose values can be the side of a square. So the values must be

positive numbers. Let’s make a slider whose values are 0 to 5. Do: Select the  Slider tool.

2. Say:  We click anywhere in the Drawing pad to start the creation. Do: Click in the Drawing pad
towards the top right corner. Say: Here is our dialog box where we tell it what we want.

We will name our slider s for “side”. Type s (it will overwrite a).

We want the minimum value to be 0. Tab to or click in Min and type 0.

1 To force the grid to be 1-1 and other options, see: Grid options

http://www.mathcasts.org/mtwiki/Standards/CA4AF-1-1
http://www.mathcasts.org/mtwiki/Standards/CA4MG-2-0
http://math247.pbworks.com/4th+Grade+Mathcasts+-+Teaching+with+GeoGebra
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We are done2. Click on Apply.

Immediately: Select the Move tool and say: all changes to the slider use the Move tool.

(If you forget and click and it wants to create another slider, just press the Esc key or click on the
Undo button in the top right of the GeoGebra window. Been there, done that a zillion times.)

With the Move tool you can click and drag the slider line to a better position and  if you don’t
see the label, right-click on the slider and select “Show label” from the drop-down menu.

3. Say:  Let’s make s=3 so our first square will have sides of length 3. Do: Select the Move tool
and then click on the slider point and drag it to 3.

4. Say:  Now we are ready to create our square. Let’s put our first point, that is our bottom left
corner point at (0,0). How did we do that before? We need the New point tool. Where do we
click? Do: Select the New Point tool and click at (0,0). Note: Most probably GeoGebra is set to
label this point with its name – in this case A. As before, you need to point out the definition of A=(0,0) in
the Algebra view and connect it to the point in the Drawing pad.

5. Say:  Let’s think for a minute. For a square with side 3, what should be the coordinates of
bottom right vertex of the square?  We would count to the right 3 units on the horizontal and
count nothing vertically. Since “H is before V” the coordinates  would be (3,0).

Say:  But we want that “3” to change when we slide our slider. What is the name of the slider? s.
So instead of (3,0), we want (s,0).

Say:  But we cannot click on the point (s,0). We must input this formula. How?

Say:  Down here in the Input bar. Let’s click in the field. Do: Point to the Input bar at the bottom
left of the GeoGebra screen and click. Say: Now our cursor is down here. Let’s type in our
formula. Do: Type: (s,0) and say and do: Hit Enter.

Very important: Make sure B is a dependent object (see Figure 1)!  Sometimes, we will
accidently define B incorrectly and sometimes GeoGebra has a wild hair and will define it as a
free object by actually substituting the current value of s.  If you see that B is a free object (see
Figure 2), double-click on it in the Algebra view. The definition will open and you should type s in
place of 3 and hit Enter (see Figure 3). It should move to the dependent objects.

6. Say:  Look – here is the new point B. It’s coordinates are (3,0). Do: Point to the point in the
Drawing pad and in the Algebra view. Say: Where is s? Let’s run our mouse over B. See – it says
Point B: (s,0). Do: Run mouse over B until definition block appears (see Figure 1).

Figure 1: Correct Figure 2: B should not be free Figure 3: Fixing B

7. Say:  Let’s see if our slider variable works by changing our slider. Do: Select the Move tool
and click and drag the slider point left and right. See: Point B should move left and right. Return
the slider to s=3.

2 You can make a minimum of 1 but kiddies like to see the square disappear  and we will animate.
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8. Say:  Now what should be the coordinates of the top right vertex of our square. Do: Count up 3
from B and see (3,3). Say:  We want the 3’s to change with our slider so we want: (s,s). Let’s type
this formula for our point in the Input bar. Do: Type: (s,s) and say and do: Hit Enter.

9. Say:  Here is our point C. We can see that it is at (3,3). Let’s check the definition. Do: Run your
mouse over C in the Algebra view until the definition block shows  Point C: (s,s) .

10. Say:  Let’s check that this point works with the slider. Do: Again, using the Move tool, click
and drag the slider point s back and forth. See: Both B and C should move – B horizontally and C
diagonally. Return the slider to s=3.

11. Say:  Now what should be the coordinates of the top left vertex of our square. Do: Count up 3
from A=(0,0) and see (0,3). Say:  We want the 3 to change with our slider so we want: (0,s). Let’s
type this formula for our point in the Input bar. Do: Type: (0,s) and say and do: Hit Enter.

12. Say:  Here is our point d. We can see that it is at (0,3). Let’s check the definition. Do: Run your
mouse over D in the Algebra view until the definition block shows  Point D: (0,s) .

13. Say: Let’s connect the points to see if we have a square. Do: Click on the Polygon tool and
then on A, on B, on C and on D and again on A. Say: A perfect square!

14. Say: Let’s see if our slider variable works. No matter what s is, we should always have a square.
Do: Using the Move tool, click and drag the slider point s back and forth. The whole square
should get larger and smaller but always be a square!

Using the Move tool, we suggest you move the labels for the points outside the square and the labels
for the sides inside the square.

What can we do in GeoGebra and some Good Questions
1. Let’s change this square to have sides of length 5. How do we do this? What will be the

coordinates of B, C and D? Have the students write down the new coordinates and then use the
Move tool to click and drag the slider to s=5.

2. We can make other formulas using s.

a. For example, what is the formula for the perimeter of the square using s? So in the Input bar,
we can type: per=4*s and hit Enter. With s=5, per=20.  Use the Move tool to click and
drag the slider to s=2 and watch the formula change to per=8. Roll your mouse over per in
the Algebra view until the definition block shows  Number per: 4 s .
[Remember (a) although we can and did enter multiplication with a *, GeoGebra immediately replaced
it with the (LaTeX) standard of a blank space. Since we do use a dot for multiplication, I usually think of
this blank as a “microdot” so small I can’t see it and (b) because the perimeter is a number, we keep
with the GeoGebra standard of using small letters and not “Per” which would mean it was a point.]

b. What is the formula for the area of a square using s? So in the Input bar, we can type:
area=s*s and hit Enter.  Remember that the value of poly1 is also the area of the square. So
check that  the value of area equals the value of poly1.  Use the Move tool to click and
drag the slider to s=1  and watch the formula change to area=1. Roll your mouse over area in
the Algebra view until the definition block shows  Number area: s s .

[Remember - although the value of area and poly1 are the same, we can always run our mouse over
each of them and they will show their different definitions.]

3. We can animate the changing square. Right-click on the slider and select Animation on from the
drop-down menu. Point out that the animation is a little jerky. (After setting Animation on, you
can stop and start the animation using the  Play and  Pause buttons which are in the lower
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left corner of the Drawing pad. When paused, you can always manually slide the slider point
with your mouse.)

Some Good Questions
4. Say: How could we make our variable s be only whole numbers? Right-click on the slider and

choose Properties from the drop-down menu. On the Basics tab, change the increment to 1
(from 0.1). Use the Move tool  to move the slider point manually. Point out that the slider is
still a line but by setting the increment to 1 we are only “looking at” whole number values for s.
Click on play to animate the slider. Now the animation is “really jerky” and slow. Mention that
although the variable s can be any positive number,  we are limiting our view to whole numbers.
(Maybe we are building a square out of blocks so hard that they cannot be broken. Then our
squares have only whole numbers for sides.)
This is important because when we make tables for functions, we often just use integer values
and then when we draw functions we draw the whole line. This is confusing, but with the slider
and animation this idea becomes much clearer.

5. If you want, have them make a table (or open the spreadsheet and make a table) with values:

s 0 1

per

6. Say: How could we make our animation smooth? Right-click on the slider and choose Properties.
Now change the increment to 0.01 and say 1/100. Try the slider manually and with animation.
Now the animation is “smooth”.

Ask them if they want to make a table for all of these values? Explain to them that we CAN make
a table with all of these values, but it would be really boring. That is why we usually just make
tables with whole number values  so that we get the idea of the pattern, but that all those
intermediate values exist.

7. You can talk about the number of steps the animation makes from one end of the slider to the
other. First think about the number of steps from 0 to 5 with an increment of 1. (Important: The
number of steps is 5 and not 6! You cannot count a step when you haven’t moved. ) Then have
them calculate the number of steps for an increment of 0.1 and of 0.01.

8. You can talk about the speed of the animation. (You can change the speed on the Slider tab.) In
GeoGebra, the speed is how long it takes from to move the point from one end of the slider to
the other. With an increment of 0.01, there are 100 more steps than with an increment of 1 so
now the time between steps is 1/100th of the time between steps when the increment was 1.

9. Mention that to be “really smooth” like in motion pictures, the increment is even smaller.
Change the increment back to 0.1 and talk about how many steps the animation makes from
one end of the slider to the other. Have them compare the time between steps now with the
time between steps  when the increment was 0.01  and again when the increment was 1. Make
sure they make their sentences complete and correctly formulated.

Where to go from here?
1. Constructing rectangles in the coordinate plane.
2. Constructing rectangles with variables in the coordinate plane.
3. Constructing squares using perpendiculars.


	Constructing Squares with a Variable Slider in the Coordinate Plane
	Setup GeoGebra for Construction (same as for Constructing Squares in the CP)
	Construction: Draw a square whose side varies by moving a slider
	What can we do in GeoGebra and some Good Questions
	Some Good Questions
	Where to go from here?


